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This README File contains installation procedures, feature highlights, and other information to 
get you started using CompuServe.  If you have already installed CompuServe, please skip 
System Requirements and Installation Notes, and continue with the sections that follow.
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1.  Upgrading to CompuServe 3.0.4

If you are running CompuServe 3.0.1 or CompuServe 3.0.2,  we recommend you upgrade to 
CompuServe 3.0.4. CompuServe 3.0.4 incorporates the latest bug fixes and mail speed 
improvements, provides better connectivity, and offers context-sensitive help.

2. System Requirements

Windows 95 Windows NT 3.51 and NT 4.0

- 8 Mb RAM (16 recommended) - 16 Mb RAM
- 60 Mb free hard disk (to install)* - 60 Mb free hard disk (to install)*
- 28 Mb free hard disk (to run) - 28 Mb free hard disk (to run)
- 486 33 or better processor - 486 33 or better 
- VGA Monitor (640x480) - VGA Monitor (640x480)
- 9600 baud (or higher) connection rate - 9600 baud (or higher) connection rate

* If you encounter errors during installation, increasing the free hard disk space to 70 or 80 Mb 
may resolve them.

3. Installation Notes

CompuServe 3.0.4 can coexist with the CompuServe Information Manager for Windows 
(WinCIM) and the CompuServe 2.x series and will share common files (like CompuServe Mail's 



Address Book).  CompuServe 3.0.4 is installed in a separate folder and will not overwrite earlier 
versions of CompuServe 3.0.x. 

It is recommended that you install CompuServe 3.0.4 in the same directory as your other 
CompuServe programs.  By doing so, CompuServe 3.0.4 will automatically have access to your 
current information, such as settings, Address Book listings, quotes, portfolio entries, your 
Favorite Places, and other information.

3.1 Installing CompuServe for Windows 95 and NT 4.0:

1.  Insert CD-ROM in drive.
2.  Click on Start Menu and choose Run.
3.  Type D:\RUN.EXE and then click OK. (Replace D: with your drive letter if different.)

Note:  If you have the Windows 95 CD AutoPlay feature enabled, the program will start 
automatically after you place the CD in the appropriate drive.

3.2 Installing CompuServe for Windows NT 3.51:

1.  Insert CD-ROM in drive.
2.  From the Program Manager, choose File and then Run.
3.  Type D:\RUN.EXE and then click OK.  (Replace D: with your drive letter if different.)
4.  If you do not have TCP/IP connectivity already installed and configured, follow the instructions 
under "Configuring the Windows NT 3.5.1 Dial-Up Remote Access Service (RAS Dialer)" in the 
next section.

4. Connectivity with CompuServe

4.1 Dial-Up Networking in CompuServe for Windows 95

The Windows 95 version of CompuServe automatically utilizes Microsoft's Dial-Up
Networking capability.

This section explains three scenarios:

1. You have no pre-existing CompuServe software on your  computer and are
installing CompuServe for the first time.  

Note:  This scenario also applies if you are replacing an earlier version of CompuServe 3.0.x with
CompuServe 3.0.4. 

Recommended Installation Method: Express

2. You are a current member and you have previous CompuServe software on your machine and 
you are installing CompuServe for the first time into the same directory as your pre-existing 
CompuServe software.

Recommended Installation Method: Express

3. You have a pre-existing Winsock, such as Trumpet or LAN connection, installed and are
installing CompuServe for the first time.

Recommended Installation Method: Custom Install

Scenario #1:  Installing CompuServe for the First Time (or as an upgrade to an earlier 
version of 3.0.x)



Express Installation:  When you choose Express installation, CompuServe automatically sets 
up Microsoft's  Dial-Up Networking by default.  When installed through the Express method, 
CompuServe also uses Microsoft's WSOCK32.DLL file.

After Express installation, your Connection Preferences will be set for Dial-Up Networking in the 
Winsock Connection Type pop-up menu and CS3 Connection in the Connect Using pop-up 
menu.

Custom Installation:  Custom installation of CompuServe gives you a choice for connectivity. 
You can either choose Install Dial-Up Networking or Use Existing Internet Connectivity, if you
don't want to use Dial-Up Networking.

If you select Install Dial-Up Networking, CompuServe will use Dial-Up Networking to connect to 
CompuServe. Your Connection Preferences will be set for Dial-Up Networking in the Winsock 
Connection Type pop-up menu and CS3 Connection in the Connect Using pop-up menu - just 
like the Express installation.

If you select Use Existing Internet Connectivity, CompuServe will not install Dial-Up
Networking and will instead use the first 32-bit Winsock it finds. The Connection Preferences will
be set for Default Winsock in the Winsock Connection Type pop-up menu and the Dial-Up
Networking box will be grayed out.

Scenario #2:  Installing CompuServe into the same directory as WinCIM 2.x

When you upgrade from WinCIM 2.0.1 and install CompuServe into the same directory 
(usually /CSERVE), CompuServe behaves exactly as it would if you had installed it for the first 
time.  Dial-Up Networking is installed by default when Express Installation is used and you can 
avoid installing Dial-Up Networking by using the Custom Installation and selecting Use Existing 
Internet Connectivity.

Installing CompuServe into the same directory as WinCIM 2.x will not affect WinCIM's connection 
process.

Scenario #3:  Installing CompuServe with a Pre-Existing Winsock

If you have a pre-existing Winsock, you will need to install using the Custom method and should 
select Use Existing Internet Connectivity when asked. Otherwise, Microsoft's install of Dial-Up 
Networking may overwrite your pre-existing Winsock.

Dial-Up Networking Phone Settings
For those of you who choose to install Dial-Up Networking, CompuServe creates a Dial-Up 
Networking connection, named "CS3 Connection," which contains the phone number to be used 
to connect to the CompuServe network.

To modify your phone settings using Dial-Up Networking after installation, select Preferences 
from the Access menu.  Then, at the Connection page, enter the phone number to dial when 
connecting to CompuServe in the Phone # box.

4.2 Configuring the Windows NT 3.5.1 Dial-Up Remote Access Service (RAS Dialer):

Unless otherwise noted all settings or selections not specifically mentioned should be left at their 
default entries. 

Assuming you have not previously added RAS: 



1. In the Control Panel, double-click the Network icon. 
2. In the Network Settings window, click the Add Software button.
3. From the pop-up list in the Network Software window, select Remote Access Service. 
4. Provide a path to your NT distribution (disks, CD, or network location).

RAS will then install, and the Remote Access Program Group will appear. 

5. In the Add Port window, select the port you will use.

RAS will offer to detect the modem connected to the port you selected. Choose OK to auto-detect
the modem. NT will show the modem detected.  Select OK.

Occasionally, NT may offer a choice of several modems to pick from.  This will only occur 
if RAS cannot distinguish between 2 or more modems with similar characteristics.

6. In the Configure Port window, the detected modem will be highlighted. In the Port Usage 
section, choose "Dial out only." 

RAS is now installed. The next step is to configure it to dial CompuServe. 

Editing SWITCH.INF

1. Using a text editor such as Notepad or Edit, add the following section to the bottom of your 
SWITCH.INF file (normally located at \WINNT\system32\ras\switch.inf): 

===========================================

[CompuServe]
COMMAND=<cr>
OK=<match>"e:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=+<cr>
OK=<match>"Host Name"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=CIS<cr>
OK=<match>"User ID:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=#######,####/GO:PPPCONNECT<cr>
OK=<match>":"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=PASSWORD<cr>
CONNECT=<ignore>

2. Be sure to put in your actual CompuServe User ID [123456,1234] and CompuServe password 
[XXXX0XXXXX] in place of ######,#### and PASSWORD. 
3. Save the file. 

Editing the RAS phonebook 

1. Go to the Remote Access Program Group and double-click the Remote Access icon. In the 



resulting window, click Add. 

You will be presented with an Add Phone Book Entry window.

2. Name the new entry "CompuServe" or whatever you want. 
3. Enter the phone number of your local CompuServe dial-up site.  Be sure to include any special 
characters needed, such as 9 to reach an outside line or *70 to disable call waiting. 
4. Leave the Description field blank (optional). 
5. Make sure that "Authenticate using current name and password" is not marked. 
6. Select the correct COM port for your modem. 
7. Click the Modem button and choose the correct port speed. Mark "Enable hardware flow 
control," "Enable modem error control," and "Enable modem compression." Do not mark "Enter 
modem commands manually." Click OK. 
8. Select the Network option. Choose PPP and mark "TCP/IP" and "Request LCP extension."
9. Click the "TCP/IP Settings" button. Choose "Server Assigned IP address" and "Use specific
name server addresses." Then enter in DNS 149.174.211.5 and DNS Backup 149.174.213.5. 
Mark both "Use VJ header compression" and "Use default gateway on remote host." 
10. Select the Security option.

Make sure "Accept any authentication including clear text" is selected. 

In the "Terminal or Script" section, select CompuServe in the pop-up menu for "After Dialing." 
(The CompuServe option will only be available if you made the necessary changes to 
SWITCH.INF.)  Then Click OK. 

Return to the Remote Access window. You will now see a new setting for CompuServe. Simply 
select Dial to connect to CompuServe.

4.3 Configuring the Windows NT 4.0 Dial-Up Remote Access Service (RAS Dialer)

Unless otherwise noted all settings or selections not specifically mentioned should be left at their 
default entries. 

Installing RAS/DUN in Windows NT 4.0

1.  Double-click on the My Computer icon and then double-click on the Dial-up Networking icon.

If RAS/DUN is not installed, you will see the Welcome to Dial-Up Networking window.

2. Click the Next button to begin.

The DUN installation will ask for the Windows NT 4.0 CD-ROM and then install the DUN/RAS 
files from it. 

Note:  You must have Administrator privileges to install RAS. TCP/IP and other necessary 
components should be installed along with RAS; if they are not installed correctly, consult your 
manual or VAR.

3.  In the Add RAS Device window, choose the modem to use with RAS/DUN and then click OK.

If no modem is installed choose Install Modem; after installing the modem, click OK. 

4.  In the Remote Access Setup window, select the Configure button. 
5.  In the Configure Port Usage window, choose "Dial out only" and then click OK. 
6.  In the Remote Access Setup window, select the Network button.



In the Network Configuraton window, be sure that only TCP/IP is marked and click OK.  Some 
additional files may be installed from the Windows NT 4.0 CD-ROM.

If there is a network interface card installed that does not already have TCP/IP bound to it, the 
Microsoft TCP/IP Properties window will appear.  Click Cancel to close the window.

If there is a network card, you will see a warning that TCP/IP is not completely configured. This 
warning refers to TCP/IP over the network and should not be set up. Select Yes.

7.  Select Restart to complete the RAS/DUN installation. 

Creating and Setting Up the Connection Entry

1.  Double-click on the My Computer icon, then double-click on the Dial-up Networking icon. 

Note:  If you are notified that RAS/DUN is not installed, refer to the steps in the previous section, 
Installing RAS/DUN in Windows NT 4.0. 

2.  In the Dial-Up Networking window, select the New button.
3.  In the New Phonebook Entry Wizard window,  enter CompuServe for the name and select the 
Next button.
4.  In the Server window mark the "I am calling the Internet" and "Send my password as plain text
if that's the only way to connect" boxes and select the Next button.
5.  In the Phone Number window, enter your local CompuServe Access phone number and select
the Next button. Enter any Alternate numbers by choosing Alternate.
6.  In the New Phonebook Entry Wizard select the Finish button

Note:  If this is the first time you have made a Dial-Up Networking entry, you will have a few more 
screens; just click on the Next button for each one.

7.  In the Dial-up Networking window select the More button, then select "Edit entry" and "modem 
properties."  You can also select "Create shortcut to entry" on this menu to place a shortcut icon 
on your desktop.
8.  The "Edit Phonebook Entry, Basic" tab lists basic information about the entry. You can also 
select the Alternates button to enter alternate phone numbers to dial. Selecting the Configure 
button will allow you to set some modem properties.
9.  After clicking the Alternates button, you can enter additional phone numbers to dial.
10.  After clicking the Configure button, you can edit some of the modem properties.
11.  Click on the Server tab and mark only TCP/IP; unmark all other boxes.  (Software 
compression can also be marked but, in rare instances, this may cause problems.)
12.  On the Server tab, select the TCP/IP Settings button. In the PPP TCP/IP Settings window, set
IP Address for "Server assigned."  Then set the DNS for "Server Assigned" also. Leave Wins all 
zeros, mark both boxes at the bottom and then click OK.
13.  Click on the the Script tab and, from the pop-up list, select cis.scp. You may also want to edit 
the script and change the "/go:pppconnect^m" to "/noint/go:pppconnect^m" to speed up the logon.
14.  Select the Before Dialing button and make sure that "None" is marked, then click OK.
15.  Click on the Security tab and mark "Use any authentication including clear text."  This is also 
where The Unsave password button will unsave your password so that you can re-enter it, if 
necessary (see step 22).
16.  Settings on the X.25 tab should be blank.  Then click OK.
17.  For additional settings, click the More button, then select User Preferences from the menu. 
18.  On the Dialing tab you can set the number of retries and whether or not DUN redials if the 
connection is lost. Set Idle seconds before hangup so that Dial-Up Networking disconnects, if left 
idle.  Also make sure the box next to the current location is marked in the Autodial by location 
box.
19.  On the Callback tab mark "No, skip callback".



20.  On the Appearance tab there are various options.  These should be left at their default 
settings.
21.  On the Phonebook tab mark "The System Phonebook."
22.  Select Dial in the Dial-up Networking window. In the Connect to CompuServe window enter 
your CompuServe User ID number (with the comma) in the User Name field and your password 
in the Password field. Leave the Domain field empty and mark Save password if you want to save
your password.  If you need to change your password, you also would need to click the Unsave 
password button on the Security tab (step 15).
23.  Click on OK to dial. Do not disturb the After Dial Terminal window, but watch the login and if 
you see the message "?? LOGINE - Invalid entry - try again" after the Password: prompt, your 
password is incorrect.
24.  In the SysTray on the Taskbar, there will be the Dial-Up Network icon.  If you right-click on 
this icon, you can hang up the connection or select Open Dial-up Monitor to get information about
your connection, including the DCE connection speed(bps) and your IP address (Details button).

Making RAS Autodial

If you are not using TCP/IP on your Ethernet card, follow these steps to make RAS autodial:

1.  Go to the Control Panel and double-click on the Network icon; then click on the Bindings Tab. 
2.  In the "Show bindings for" drop-down list, select "All Protocols."
3.  Click on the plus sign next to TCP/IP and WINS Client(TCP/IP). 
4.  Select the Ethernet card on both the TCP/IP and WINS Client; then click the Disable button.
5.  Click OK.  Then click Yes in the Network Setting Change window to restart your computer. 
6.  In the Control Panel, double-click on Services. 
7.  In the Service Control Panel, make sure that "Remote Access Autodial Manager" is started 
and set to Automatic. (It should be set to Automatic by default.  If it is not, click Startup and then 
change the Startup Type to Automatic.) 

After you've completed these steps, RAS will autodial the connection whenever you start a 
Winsock application. 

Interpreting Error Messages:  "Could not resolve Gateway.compuserve.com" or "Winsock 
Error: Host not found"

There are two basic reasons these error messages occur.

1.  The modem did not dial/connect and therefore it cannot get to the DNS servers or the 
Compuserve host.  

Suggested solution:  Try starting the connection first.

2.  A problem has occurred with the DNS entries in the Network Control panel. 

Suggested solution:  If you are not running TCP/IP on your network,  disable TCP/IP on the 
ethernet card as described in the previous section, Making RAS Autodial.

If you are running TCP/IP on your network, go to the Control Panel, then double-click on the 
Network icon. In the Network control panel, click the Protocols tab, double-click on TCP/IP, and 
then click the DNS tab.  To solve the problem, you will need to add one of the CompuServe DNS 
servers (149.174.213.5 or 149.174.211.5) to the list in the DNS window. 

4.4 Signup or Startup?

Based on whether it finds a CIS.INI file or not, CompuServe can usually determine your 
membership status and will prompt you to sign up a new account or set up the software (if you 



are an existing member).

If a CIS.INI file is not detected, you will see the Welcome window, where you can either sign up a 
new account or set up the software.  New members should always select Signup from the 
Welcome window.  Be sure to exit all applications, including screen savers and toolbars, before 
starting the signup process.

However, if you already have a CompuServe account and are running from a directory where 
CIS.INI cannot be found, you will need to select Setup.

Current members should note that CompuServe 3.0.4 does not include a Winsock checkbox in 
the Connection settings, as the WinCIM 2.x series does.  All CompuServe 3.0.4 connections 
require PPP and use Winsock. This feature enables us to provide easy Internet access and new 
built-in multi-tasking support.
 
5. Upgrading Your Filing Cabinet

The CompuServe Filing Cabinet stores Mail messages, Forum messages, news articles (stories),
and other types of text articles that you want to review or use later.  Simply click the File It button 
in the message or article window, and then select or create the folder in which you want to store 
it.

To access the Filing Cabinet, click the My Information side button (on the Home Desktop), and 
then click the Filing Cabinet top tab.  Or, select the Filing Cabinet button located on the toolbar.

5.1 Filing Cabinet Conversion

The Filing Cabinet in CompuServe 3.0.4 uses a different format than the Filing Cabinets in 
CompuServe software prior to CompuServe 3.  Items stored in the WinCIM Filing Cabinet must 
be converted before you can view them in CompuServe 3.0.4.  However, you can view Filing 
Cabinet items stored in more recent versions of CompuServe's software (CompuServe 3.0 and 
later) with CompuServe 3.0.4.

If you install CompuServe (3.0 and later versions) into the same directory as your other 
CompuServe products, items in your WinCIM Filing Cabinet are converted automatically the first 
time you use CompuServe.

Filing Cabinet Conversion Utility
This utility converts the contents of a Filing Cabinet created with versions of WinCIM, DOSCIM, 
and CSNav to the new CompuServe 3 format.  Although it runs automatically the first time you 
install CompuServe 3.0.4, it can be run any time.

To convert the contents of the Filing Cabinet after the initial installation of CompuServe: 

1. Start the Filing Cabinet Conversion Utility (located in the CompuServe program group).
2. Type the source and destination directory paths in the Convert Filing Cabinet window.
3. Click Begin.

5.2 Filing Cabinet Utility

This utility enables you to perform backup and general maintenance on your Filing Cabinet.  In 
addition to backup, you can use it to recover wasted space, repair damaged records, and merge 
information from multiple Filing Cabinets.  Features include:

- Backup
- Restore



- Compress
- Repair
- Statistics

    - Preferences

To back up (copy) your Filing Cabinet:

1. Start the Filing Cabinet Backup Utility (located in the CompuServe program group).
2. Choose the Copy to file command from the File menu.

A window will be displayed where you can specify the current Filing Cabinet directory and the 
name of the file (backup file) you want to create.

General maintenance tasks can be performed using appropriate commands on the Filing Cabinet 
menu.

6.  Setting Up Netscape Navigator as Your External Web Browser

These instructions apply to Netscape Navigator 2.0.2 and higher.

In CompuServe:

1.  Select Preferences from the Access menu.
2.  Click on the General top tab.
3.  Click the Select button.
4.  Find NETSCAPE.EXE and double-click it.
5.  On the General top tab, mark the "Use external Internet browser" checkbox and click OK.

In Netscape Navigator:

1.  Choose General Preferences from the Options menu.
2.  Click on the Helpers top tab.
3.  Click the Create New Type button.
4.  In the Mime Type field, enter "application" (no quotes).
5.  In the Mime sub-type field, enter "x-gocserve" (no quotes).
6.  Click OK.
7.  In the File Extension field on the Helper tab, enter "go" (no quotes).
8.  Mark the "Launch the application" option.
9.  Click the Browse button and double-click GOCSERVE.EXE. Then click OK.

7. Feature Highlights of CompuServe

A New Multimedia Look

CompuServe has a redesigned, multimedia interface that is graphically rich and easy to navigate.
It also allows automatic viewing of files such as charts, photos, and other multimedia files.

New Web Browser for Windows 95 and Windows NT 4.0:
Microsoft Internet Explorer 3.02

We also offer complete, easy access to the Internet through our integrated Web browser from 
Microsoft, Internet Explorer 3.0.2.

CompuServe contains the latest version of Internet Explorer 3.0.2.  If you have the same (or an 
older) version installed on your computer, then CompuServe will install the newest version to 
ensure that you are running the latest software and that your current installation is complete.  If 



you currently have a newer version than the one in CompuServe installed, CompuServe will use 
it.

For Windows NT 3.51 users, we offer Internet access with Microsoft Internet Explorer 2.1.

Multi-Tasking

CompuServe has multi-tasking capability, which saves you time by allowing you to perform 
multiple tasks simultaneously.  Use the To-Do List to manage retrieval of messages and files in 
the 'background,' while you are doing other online activities, such as reading news articles or 
browsing a Forum area in the 'foreground.'

Personalized, Customizable Features

CompuServe provides time-saving, organizational tools that let you track where you've been by 
checking your list of recently visited places, save frequently-visited places in your Favorite Places
list, or customize your toolbar for easy access to frequently-used tasks.

Free Software

Look in your \BONUS_W directory on your CD-ROM drive (D: in most cases) for free bonus 
software.  Included on your CD are titles such as WorldsAway, Air Warrior II, BattleTech, Adobe 
Acrobat, Casino Poker, and more.  Just install the software you're interested in and enjoy - 
compliments of CompuServe.

8. Support Information

8.1 Help System

Learn About Help:  Most main desktops have a Learn About side button, which you can click to 
find out how to accomplish your tasks using the desktop features.  If you're a new member, new 
to CompuServe 3.0.4, or not a frequent user, Learn About Help is a good place to begin.

Help Menu:  To learn how to use the Help system, choose "How to Use Help" from the Help 
Menu.  Choose "Contents" from the Help menu to view the Help system's table of contents.  

8.2 Online Resources

Once you have installed CompuServe and become a member, you can connect to CompuServe 
for a wealth of information, software, and services.  Simply click the Assistance top tab on the 
Home Desktop, then click Member Services to view a menu of available resources for help and 
assistance.  For information and support on CompuServe 3.0.4,  type GO CSWIN to go directly to
the support area for CompuServe software for Windows.

9. Recovering Hard Disk Space

If you need additional space on your hard drive, here are some suggestions:

- Deleting old WinCIM Signup files will recover 600K.  To do so, delete C:\CSERVE\WINSIGN.

- Deleting Mosaic cache files will recover up to 5 Mb (if you used the default cache size).  To do 
so, delete C:\CSERVE\MOSAIC\CACHE.

- Deleting the Mosaic software will free up to to 1.9 Mb.  However, be aware that this will also 
remove any hotlists you have in Mosaic.  To do so, delete C:\CSERVE\MOSAIC.



- If you no longer need to use WinCIM, you can recover approximately 2 Mb by deleting   C:\
CSERVE\WINCIM.

Caution:  Do not delete the contents of your C:\CSERVE directory when you are deleting the sub-
directories.

10.  Proxy Servers and Firewalls

In general, CompuServe 3.0.4 uses port 4144 to communicate to gateway.compuserve.com.  
Because there are so many different Proxy Server and Firewall setups, individual setups cannot 
be covered here.  You'll need to contact your System Administrator about the proper setup.


